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A1A1A1A1    Revision HistoryRevision HistoryRevision HistoryRevision History    

No. Date Subject 

1.0 July 06, 2006 First released document. 
1.1 June 10, 2008 Revised 
1.2 November 27, 2009 Some remarks added if used with option T. 

Corrections at “Link” function. 
1.3 October 26, 2010 Revised. 
1.4 November 16, 2011 Now available for XI modules as well. 

A2A2A2A2    CopyrightCopyrightCopyrightCopyright    
Copyright © Alpermann+Velte Electronic Engineering GmbH 2002.  All rights reserved. No 
part of this publication may be reproduced, translated into another language, stored in a 
retrieval system, or transmitted, in any form or by any means, electronic, mechanical, 
photocopying, recording, or otherwise without the prior written consent of Alpermann+Velte 
Electronic Engineering GmbH. 

Printed in Germany. 

Technical changes are reserved. 

All brand and product names mentioned herein are used for identification purposes only, and 
are trademarks or registered trademarks of their respective holders. 

Information in this publication replaces all previously published information. Alpermann+Velte 
Electronic Engineering GmbH assumes no responsibility for errors or omissions.  Neither is any 
liability assumed for damages resulting from the use of the information contained herein.  

For further information please contact your local dealer or: 

Alpermann+Velte 

Electronic Engineering GmbH 
Otto-Hahn-Str. 42 
D-42369 Wuppertal 
Phone: ++49 - (0)202 – 244 111 0 
Fax: ++49 - (0)202 – 244 111 5 
E-Mail: info@alpermann-velte.com 
Internet: http://www.alpermann-velte.com 
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A3A3A3A3    General RemarksGeneral RemarksGeneral RemarksGeneral Remarks    
This manual is a supplement to the “Installation & Systems Manual RUBIDIUM SERIES”. It 
describes a special operating mode of AI or DI or HI or XI modules realized by the appropriate 
firmware. Please read the below listed chapters of the “Installation & Systems Manual 
RUBIDIUM SERIES”, as these chapters are necessary for the safe and proper use of Rubidium 
modules AI or DI or HI or XI. 

  

• A3 Warranty, 

• A4 Unpacking/Shipping/Repackaging Information, 

• A5 Safety Instructions, 

• A6 Certifications & Compliances, 

• Plug-In a Module, 

• Remove a Module. 
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1 Daytime Inserter 

1.1 Description 
The “Daytime Inserter” feature enables the module to visibly insert a time and a date in a 
video window. This insertion may be positioned all over the entire screen. Different formats of 
character representation are selectable. For example the time can have a HH:MM:SS:1/100 
format, the date a Day.Month.Year format. All settings will be non-volatile stored in the 
module. The Rubidium module defines the video channel: 

RUB AI: CVBS analogue video 525/60 (NTSC) or 625/50 (PAL). 

RUB DI: Digital video channel (SD). 

RUB HI: HD or SD digital video channel. 

RUB XI: 3G or HD or SD digital video channel. 

The internal clock of the module has to receive a start value after power-on, i.e. a time and a 
date has to be set. This can be done in the following way: 

External Reference: In a basic operating mode the module is ready to receive a time & 
date information via serial interface, and a precise PPS (pulse per second) as the timing 
reference. With these inputs the internal clock will be synchronized. A DCF77 or GPS 
receiver as well as a PC may be the source of these signals. Without the option T the 
time and the date will stay at zero, until the external reference has synchronized the 
internal clock. Dependant on the system this may last some minutes, for example if a 
GPS receiver simultaneously has been switched on with the module and it has to track 
the satellites first. 

Option T: With this option a battery-buffered real-time chip has been assembled. This 
chip makes a time & date available after power-on, even if no external reference has 
been connected. The time & date can be set manually utilizing the RUBIDIUM CONFI-
GURATION PC program or the RUBIDIUM SERIES HTTP server. If an external reference 
has been connected, the real-time chip will be synchronized to the reference. 

Option G: This option denotes an adapter cable, which makes it easy to plug the exter-
nal reference. For the external reference please choose a device which has been recom-
mended by Alpermann+Velte.  
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1.2 Connecting an External Reference 
The Rubidium module receives time & date via a serial interface (signal “RxD“ at DSUB SERIAL) 
and a PPS (signal “PPS Input“ at DSUB GPI). The voltage output (“24 VDC Out“ at DSUB GPI) 
may be used to deliver power to the external reference. 

11

GPI

Alpermann+Velte

Rubidium AI/DI/HI/XI Module

DSUB: GPI
1: PPS Input
5: GND
6: 24 VDC Out

DSUB: SERIAL
5: GND
7: RxD (RS232 Receive)

SERIAL

 

An adapter cable may be ordered as an accessory (option G). This cable will be manufactured 
suitable to link the module and the external reference: 

GPS

11

Alpermann+Velte

K_RJ_D11

RJ45
Coupler

GPISERIAL
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1.3 Time Zone 
If once synchronized the internal clock counts the time & date automatically. An automatic 
Daylight Saving Time switching is programmable. The time zone of the internal clock may 
have any offset to the time zone of the external reference.    

The internal time base is the UTC (Universal Time Coordinated, GMT, world time). The 
module calculates the UTC from the reference input and the selected offset to UTC. This set-up 
is part of the configuration utilizing the RUBIDIUM CONFIGURATION PC program (at the 
‘Time Zone’ tab) or the RUBIDIUM SERIES HTTP server (at the ‘Time Zone’ page). 

The visibly displayed time & date is equal to the time & date of the internal clock, this repre-
sents the local time zone. The module calculates the local time zone from the UTC time base 
and the selected offset to UTC. This set-up is part of the configuration utilizing the RUBIDIUM 
CONFIGURATION PC program (at the ‘Time Zone’ tab) or the RUBIDIUM SERIES HTTP server 
(at the ‘Time Zone’ page). 

The operator has to know the time zone of the reference, in order that the module can be con-
figured with the correct offsets to UTC. If the reference utilizes DST (Daylight Saving Time), 
then the reference must send status information which indicates the current time zone (DST yes 
or no). 

The local time zone can be selected independently from the reference, if the UTC time base 
can be calculated correctly. For example a DST switching of the local time zone can occur at 
different moments than it will occur for the reference time zone with DST. 

If the time zone of the reference is not known and the local time zone should simply follow the 
reference, set the offsets to UTC to zero (regarding the reference offsets), and select the local 
time zone as “Same As Reference Input“ utilizing the RUBIDIUM CONFIGURATION PC pro-
gram (at the ‘Reference’ tab) or the RUBIDIUM SERIES HTTP server (at the ‘Reference’ page). 
The local time zone still can get offsets. 

Details of the configuration are described in the chapters “Reference: Synchronization to a 
Time & Date Reference” and “Time Zone: Time Zone Adjustment“. 

With option T the time & date of the battery buffered real-time chip can be set manually: 
Utilizing the RUBIDIUM CONFIGURATION PC program (at the ‘Generate’ tab) or the 
RUBIDIUM SERIES HTTP server (at the ‘Generate’ page). Time & date must correspond to the 
local time zone. 
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1.4 Functional Description 
The module visibly inserts time & date in a video window. Time & date will be generated by 
the internal clock which can be set and synchronized. This chapter describes the most impor-
tant details of how the module operates. 

Operating mode just after power-on with an external reference connected 

This describes a power-up sequence, at which the module and a GPS receiver have been 
switched on simultaneously. The four programmable status LEDs at the front of the module are 
set into the default state. 

Time after 
power-on 

LEDs Description Time & date of 
the internal clock 

0 – ≈ 60 s OPER: On. 
SIGNAL: Rapidly 
flashing. 
SET: Off. 
ERROR: On. 

Boot procedure. 
The module waits for serial data and 
the PPS signal. 
GPS receiver tracks satellites. 

00:00:00:00 
00.00.2000 

≈ 60 – 70 s OPER: Blinks 
once a second. 
SIGNAL: Slowly 
flashing. 
SET: On or 
flashing. 
ERROR: Off or 
flashing. 

GPS receiver has synchronized. 
The module receives serial data and 
the PPS signal. The internal clock tries 
to phase-lock to the PPS signal. 
 

13:27:59:98 
24.12.2006 

> 70 s OPER: Blinks 
once a second. 
SIGNAL: On. 
SET: On. 
ERROR: Off. 

The internal clock has been 
synchronized. 
The internal clock has been set with 
time & date. 

13:28:09:98 
24.12.2006 

 If everything works normal it can be verified by looking at the four LEDs: 

 LED LED function  

 OPER OPER Blinks every second. 

 SIGNAL Gen Sync Status Lights-up. 

 SET SET Lights-up. 

 ERROR ERROR Off. 
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Basic configuration 

Upon delivery the module has been set to a basic configuration, so that the system consisting 
of an external reference and the module is operative. If there are fundamental problems the 
basic configuration can be installed with three steps: 

1. “Factory Settings” 
Select at the “Profile“ page or tab: Profile: Factory Settings 

Click on the OK button. 

 

2. Select the data protocol of the external reference: 
Refer to chapter “Reference: Synchronization to a Time & Date Reference”. Select 
the correct Format.  

3. Select the time zones: 
Refer to chapter “Time Zone: Time Zone Adjustment“. Select the time zone of the 
reference (usually = UTC) and of the local time.  

Time & date representation in a video window  

Select the format of character representation utilizing the RUBIDIUM CONFIGURATION PC 
program (at the ‘Insert’ tab) or the RUBIDIUM SERIES HTTP server (at the ‘Insert’ page). 

Select Format: time & date representation: 

Time Date 
HH:MM:SS:FF FF = 1/100 DD.MM.YYYY Day.Month.Year (year with 4 digits) 
HH:MM:SS    MM.DD.YYYY Month.Day.Year (year with 4 digits) 
MM:SS:FF FF = 1/100 YYYY.MM.DD Year.Month.Day (year with 4 digits) 
HH:MM  DD.MM.YY Day.Month.Year (year with 2 digits) 
MMMM:SS hours converted to 

minutes  
MM.DD.YY Month.Day.Year (year with 2 digits) 

MM:SS  YY.MM.DD Year.Month.Day (year with 2 digits) 
SS:FF FF = 1/100  

Select Delimiter: select separate for time and date 

Selection Example 
off 17513998 
  (Blank)  17   51   39   98 
: (Colon) 17 : 51 : 39 : 98 
. (Dot) 17 . 51 . 39 . 98 
- (Dash) 17 - 51 - 39 - 98 
/ (Slash) 17 / 51 / 39 / 98 
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2 Modules AI, DI, HI and XI 

2.1 Overview 
The hardware consists of the video channel, the inputs for the external reference as well as 
some general purpose interfaces, which may be used for various special applications (GPI 
in/outputs). 

A PC is required for the initial set-up and for configuration of this module. The front panel 
label visibly identifies where each module is located:  

AI: CVBS analogue video 525/60 (NTSC) or 625/50 (PAL). 

DI: Digital video channel (SD). 

HI: HD or SD digital video channel. 

XI: 3G or HD or SD digital video channel. 

The serial number is located on the bottom side of the lower circuit board of each module. 

The standard hardware of this module has all of the following key features:  

• “Hot Swapping“, i.e. it is possible to insert or remove a module without interrupting the 
operation of other modules in this frame. 

• Failure relay, connected to the FAIL_A and FAIL_B pins of the RLC connector at the rear of 
the frame. 

• RS232 and TC_link (RLC connector) interfaces to have access to the internal bus of the 
chassis. 

• Serial interface to receive time & date. 

• Precise genlocking to an external PPS (pulse per second) signal. 

• Video input/output to insert characters. 

• Four programmable function keys on the front panel. 

• Flash memory containing the firmware, so configuration and updates are possible via a 
PC connection (email attachments with software/firmware update files are possible). 

• Four digital in- or outputs and one relay contact may be used in special applications. 
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2.2 Rear Panels and Connections 
Connections at AI/DI – version 1 Connections at HI/XI and AI/DI – version 2 

GPISERIAL
11

VIDEO OUTVIDEO INLOOP OUT

Alpermann+Velte

 

11

SERIAL GPI

VIDEO OUTLOOP OUTVIDEO IN

Alpermann+Velte

 

Pin assignments 

SERIAL 
DSUB9F female 

1: T-_TxD 
2: T+_CTS 
3: LTC_OUT_A 
4: LTC_OUT_B 
5: GND 
6: R-_RTS 
7: R+_RxD 
8: GPI_3 
9: GPI_4 

 

GPI 
DSUB9F female 

1: GPI_1 (PPS Input) 
2: GPI_2 
3: GPI_3 
4: GPI_4 
5: GND 
6: 24 VDC Out 
7: GPI_5 
8: LTC_IN_A 
9: LTC_IN_B 
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Signal descriptions 

GND Signal ground. 
 

LTC_IN_A, LTC_IN_B Reserved. 
 

LTC_OUT_A, LTC_OUT_B Reserved. 
 

T-_TxD 

T+_CTS 

R-_RTS 

R+_RxD 

In- or outputs of the local serial interface. By configuration 
(selection of the source of reference) the appropriate 
electrical interface will be selected automatically: 

RS485: Signals T- and T+, balanced in/output. 

RS422: Signals T- and T+ = balanced output, 
signals R- and R+ = balanced input. 

RS232: TxD = transmit line, unbalanced data output. 
CTS = clear to send, handshake input. 
RTS = request to send, handshake output. 
RxD = receive line, unbalanced data input. 

 

GPI_1 ... GPI_4 General Purpose Interface, may be used as input or as 
output for digital signals according to application. 

 

GPI_5 Relay contact (normally open). The relay contact shortens 
this pin to GND. 

 

24 VDC Out 
 

24 VDC voltage output, 200 mA reversible fused. This 
output corresponds to the voltage output of the inserted 
“Power Supply“ module. Please notice the power supply 
specifications. 

 Using this output please make sure not to exceed 
the total power rating of the “Power Supply“ module. 
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2.3 Specifications 
Video channel VIDEO IN/LOOP OUT/VIDEO OUT 

 AI DI HI XI 
Format Analogue CVBS: 

PAL 625/50, 
NTSC 525/60 

Serial digital, 
SMPTE 259M 

Serial digital, 
HD: SMPTE 292M 
SD: SMPTE 259M 

Serial digital, 
3G: SMPTE 424M 
HD: SMPTE 292M 
SD: SMPTE 259M 

Signal level 
VIDEO IN 

1 V ± 15 mV 800 mV ± 10 % 

Signal level 
LOOP OUT 

Loop-through of 
VIDEO IN 

800 mV ± 10 % 

Signal level 
VIDEO OUT 

Gain 1 ± 1 % 
(adjustable ± 4 %) 

800 mV ± 10 % 

Connector BNC (IEC 60169-8), 75 Ω 

Accuracy of the internal clock 

PPS synchronous Accuracy equal to the accuracy of the PPS signal.  
Temperature dependant drift  
(no PPS connected) 

< ± 50 ppm (4 s/day) 

Option T: Accuracy of time 
during power-off state 

< ± 7 ppm (0.6 s/day) 

GPI 

GPI_1 ... GPI_4: 
Input specification 

Input “Low“: -2.0 to +1.0 V 
Input “High“: +3.0 to +24.0 V 
Impedance: 4.7 kΩ 
Frequency: 0 - 1 MHz 

GPI_1 ... GPI_4: 
Output specification 

Open Collector output of a NPN transistor at 4k7 pull-up 
resistor (5 VDC). Max. power dissipation: 200 mW. 

„High“ state: 4.3 V (no load). 

„Low“ state:  Output switched to GND. 
Max. collector current: 100 mA DC, fused by a 100 mA auto-

recovery fuse. 
Collector-emitter saturation voltage: 

@100 mA: typ. 200 mV (≤ 600 mV), 
@10 mA: typ. 90 mV (≤ 250 mV).   

Frequency: 0 - 150 kHz. 

GPI_5: 
SPST-NO relay 

Contact resistance:  0.2 Ω 
Max. switching power:  10 W 
Max. switching voltage:  175 VDC 
Max. switching current: 0.5 A 
Max. transportable current: 0.8 A 
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24 VDC Out 

Output of the DC power 
supply of this module, 
normally = 24 VDC. 

Reversible fused. A continuous current of up to 120 mA can 
be applied over the whole specified operating temperature 
range. At an ambient temperature of e.g. 22 °C the output 
switches to a high-resistance state after a few seconds if a 
current of 300 mA is applied. 

Others 

Operating voltage 12 - 30 VDC 
Power consumption AI modules (hardware version 1): Max. 5.0 W 

AI modules (hardware version 2): Max. 5.0 W 
DI modules (hardware version 1): Max. 4.5 W 
DI modules (hardware version 2): Max. 5.9 W 
HI modules: Max. 6.2 W 
XI modules: Max. 4.7 W 

Weight 0.4 kg approx. 
Mechanical 2 circuit boards (W x D): 100 x 160 mm / 3.94 x 6.30 inch 

Rear panel: Rub H1: 103 x 44 mm / 4.06 x 1.73 inch 
  Rub H3: 8HP, 3RU 

Environmental character-
istics, operating 

Temperature: 5 °C to 40 °C 
Relative humidity: 30 % to 85 %, non-condensing 

Environmental character-
istics, non-operating 

Temperature: -10 °C to +60 °C 
Relative humidity: 5 % to 95 %, non-condensing  
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2.4 Software Update 
Software updates require a (windows operating system) computer and the “RUBIDIUM 
CONFIGURATION“ program. 

Please check the PC connector at your RUBIDIUM housing: There is an USB or RS232 (with a 
DSUB9 connector) interface installed. You now need the same interface at your computer.  

The new firmware should already be stored as a .tcf.tcf.tcf.tcf file at your computer. 

Please now execute the following steps: 

1. Connect your computer to the PC connector of that RUBIDIUM frame where the module 
has been plugged. 

In case of an RS232 interface: Use a straight (1:1) connection between the PC connector 
at the RUBIDIUM frame and the RS232 of the computer. 

In case of an USB interface: Use a USB A-B cable between your computer and the 
RUBIDIUM frame. 

Switch on the power of all units. 

2. Execute “Rubidium Config.exe” on your computer. Select the “Port” according to the 
interface (USB, RS232) you are using. 

3. Select the module (unit 1, 2, 3 ...). 

4. Select “Flash Update“ in the File menu. 

5. Open the .tcf-file. The following options are available at present: 
OPT31 = With external reference, without option T, 
OPT56 = Without external reference, including option T. 
From this the following standard files result: 
“Rubidium AI OPT31 version.tcf“ or “Rubidium AI OPT51 version.tcf“. 
“Rubidium AI (v2) OPT31 version.tcf“ or “Rubidium AI (v2) OPT51 version.tcf“. 
“Rubidium DI OPT31 version.tcf“ or “Rubidium DI OPT51 version.tcf“. 
“Rubidium DI (v2) OPT31 version.tcf“ or “Rubidium DI (v2) OPT51 version.tcf“. 
“Rubidium HI OPT31 version.tcf“ or “Rubidium HI OPT51 version.tcf“. 
“Rubidium XI OPT31 version.tcf“ or “Rubidium XI OPT51 version.tcf“. 

 “version” stands for a revision no., e.g. 2.0.184. 

Click the OK button, update starts. Click the OK button at the end. 

6. Update is finished now. We recommend to check module’s configuration utilizing the 
“RUBIDIUM CONFIGURATION“ program. 

 

During the flash update the operation of the module stops! 
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3 The Rubidium Configuration Tools 

3.1 The Rubidium Configuration PC Program 
Please refer to the 

“Installation & Systems Manual RUBIDIUM SERIES” 

for a general description of this program and how to install it. At this document please notice 
the following subchapters: 

• Overview 

• Installation 

• Connection to RUBIDIUM SERIES Chassis 

• Starting the Program 

• Store, Load and Update the Configuration on your PC 

• The “Profile” Tab: Store and Load Configurations on the Module 

• The “System” Tab: Module Identification, Reset, SNMP, Fan Control … 

The program RUBIDIUM CONFIGURATION uses various tab cards. With one click on the 
button Configure, all available and currently activated tabs of this specific module are 
displayed. 

Any changes at a tab will immediately be stored at the module. If you enter a number or a text 
press the tabulator key at the PC’s keyboard afterwards. 
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3.2 The Rubidium Series HTTP Server 
Please refer to the 

“Installation & Systems Manual RUBIDIUM SERIES” 

for a functional overview and for an installation description of this program. You will find the 
chapter “The RUBIDIUM SERIES HTTP Server” and its subchapters: 

• Overview, Connecting the IE Module 

• IP Configuration, the Rubidium Homepage 

• Access to a RUBIDIUM SERIES Module 

• The “Profile” Page: Store and Load Configurations on the Module or on the PC 

• The “System” Page: Module Identification, Reset, SNMP, Fan Control … 

As soon as a communication to a single module has been established, the Configuration 
page gives a list of all the links, which correspond to all the currently available or used pages 
of this specific module. 

Changes at a page will not be stored at the module automatically. At the bottom of each page 
there are two buttons which should be used to store or load the module’s configuration: 

Button Save To Module: 

• Click on this button to transfer all settings on this page to the module. 

Button Reload From Module: 

• Click on this button to load the current configuration of the module. 

 

AI
 

Every time you click on the blue button which indicates the module under 
configuration a Reload will be done automatically. 
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3.3 “Functions“ 
Click on Functions to see all applicable tabs/pages listed, and to activate or deactivate 
tabs/pages. For example (screen shot of the PC program tab): 

 

A tab/page reflects a function of the module. The columns Edit and Use determine whether 
the function in the module is activated/deactivated and whether user configuration of that 
specific function is allowed or not.   

Click on the applicable Edit and/or Use check-boxes to activate/deactivate a function:  

Edit Use  

  Function is deactivated, the tab is not visible. 

√ √ Function is activated, the tab is visible and configurable. 

 √ Function is activated but the tab not visible and therefore not configurable. 

 

• We suggest that you deactivate the Use check-boxes of all functions you are presently 
not using.  

• We suggest that you deactivate the Edit check-boxes of all functions you are presently 
not configuring. That avoids unintentional operating and malfunctions. 

List of tabs/functions: 

System: Identification, Reset, SNMP Traps, Fan Control … (*1) 
Keys: Keys, Lamps, LEDs and GPIs 
Video: Video System and General Setup of the Video Channel 
Insert: Setup of all Video Windows 
Generate: PPS Signal and Manually Time Set (*2) 
Reference: Synchronization to a Time & Date Reference (*2) 
Time Zone: Time Zone Adjustment (*2) 
Link: Communication between Modules (*2) 
Profile: Store and Load Configurations on the Module (*1, *2) 

*1: Refer to “Installation & Systems Manual RUBIDIUM SERIES” 

*2: This is a basic function of this special module, so no Edit and Use check boxes have 
been provided. 
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3.4 “Keys“: Keys, Lamps, LEDs and GPIs 
The module has four illuminated buttons (keys and lamps), four LEDs (Light Emitting Diodes) 
and four GPIs (General Purpose Interface). The functions of these in- and outputs are 
programmable. 

Some functions are assigned to special options, and therefore are not applicable with the 
standard firmware. For further information, please contact Alpermann+Velte. 

Configuration (example shows a screen shot of the PC program tab): 

 
Function Keys 

Four keys F1, F2, F3 and F4 can get a function independently from each other. Select a 
function from the dropdown list. This selects the function of the lamps as well. 

Remark: 
In a typical application the keys get a “Load Profile“ function. For example select different 
positions for the video window, each configuration should be stored as a separate ‚profile’. 
A simple key stroke will then recall this configuration. 

 
LED 

Four LEDs (named OPER, SIGNAL, SET and ERROR) can get a function independently from 
each other. Select a function from the dropdown list. 

Remark: 
It is recommended not to change the basic setup of these LEDs, because this special 
firmware uses the basic functions to visualize the most important signals – please notice 
chapter “Functional Description” for details. 
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GPI 

Four GPIs can get a function independently from each other, as an input or as an output. 
Additionally the switching characteristic (as a push button or a toggle switch) is selectable. 
Select from the dropdown lists. 

Remark: 
GPI 1 is the input for the external pulse per second signal (PPS). Please do not select a 
function for this GPI. 
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3.5 “Generate“: PPS Signal and Manually Time Set 
The module has an internal clock built-in. In an operating with an external reference this clock 
tries to phase-lock to the PPS signal. Without an external reference the clock will lock to the 
internal oscillator. The clock can manually be set to a time and date. 

Configuration (example shows a screen shot of the PC program tab): 

 

Sec-Pulse: Select the reference edge of the external PPS signal: 
Rising Edge 
Falling Edge 

Realtime 

Option T only: You can set time and date of the internal clock. This may be useful if there is 
the option T installed and no external reference is connected. It is necessary only if the 
internal clock shows a significant deviation compared the actual local time. In the power-off 
state the time will be count by a battery buffered real-time chip. 
 
Time: Enter a time (HH:MM:SS). The values set will be stored in the module. Press the Set 

Realtime button to set the time of the internal clock.  

Date: Enter day (D), month (M) and year (Y). The values set will be stored in the module. 
Press the Set Date button to set the date of the internal clock.  
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3.6 “Reference“: Synchronization to a Time & Date 
Reference  

Define the reference source, the time zone status and the mode of synchronisation. 

Configuration (example shows a screen shot of the PC program tab): 

 

Reference 

Select the signal source and the data format: 

Source: Indicates the current selected source. At present there is no selection possible.  

Format: Indicates the current selected data format. At present there are some serial data 
protocols selectable. The selected protocol has to match the serial data format of 
the external reference. 
Example: “Meinberg Std 2400/7e2 + PPS“: Appropriate for GPS 10 MHz. 

“$GPRMC 4800/8n1 + PPS“: Appropriate for GPS35 or GPS16.   

Time Zone and DST Mode 

Define the time zone of the reference and the local time zone of the internal clock. 

Reference Input: The module uses the UTC (Universal Time Coordinated, GMT, world time) 
as an internal time base. With these settings and the settings Offset Reference 
Input at the Time Zone tab the module can calculate the UTC from the reference 
input. 
AUTO: Time, date and status data of the signal input indicate the time zone of 

the reference. The reference may utilize DST (Daylight Saving Time). The 
settings “Offset from UTC“ and “DST Bias“ at the Time Zone tab will be  
used. 
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UTC: The time zone of the reference does not utilize DST (Daylight Saving 
Time), the ‘UTC’ status will be set for internal use. The setting “Offset 
from UTC“ at the Time Zone tab will be used! 

Standard Time Only: The time zone of the reference does not utilize DST (Daylight 
Saving Time), the ‘Standard Time’ status will be set for internal use. The 
setting “Offset from UTC“ at the Time Zone tab will be used. 

Daylight Saving Time Only: The time zone of the reference does not switch the DST 
(Daylight Saving Time), the ‘DST’ status will be set for internal use. The 
settings “Offset from UTC“ and “DST Bias“ at the Time Zone tab will be  
used. 

GT Time Zone: These settings refer to the local time zone status of the internal clock and to 
the priority of reference time versus local time at the moment of synchronisation. 

Auto + Reference Check: The local time zone utilizes DST, the switching occurs 
automatically according to the settings at the Time Zone tab. At the 
moment of synchronisation (according to the “Periodically” setting at 
Mode of GT Time Zone Synchronisation) the time of the reference 
may not differ more than one minute from the expected time value. 

UTC + Reference Check: The local time zone does not utilize DST (Daylight Saving 
Time), the ‘UTC’ status will be set for internal use. The setting “Offset 
from UTC“ at the Time Zone tab will be used! At the moment of syn-
chronisation (according to the “Periodically” setting at Mode of GT Time 
Zone Synchronisation) the time of the reference may not differ more 
than one minute from the expected time value. 

UTC: The local time zone does not utilize DST (Daylight Saving Time), the 
‘UTC’ status will be set for internal use. The setting “Offset from UTC“ at 
the Time Zone tab will be used! 

Standard Time Only: The local time zone does not utilize DST (Daylight Saving 
Time), the ‘Standard Time’ status will be set for internal use. The setting 
“Offset from UTC“ at the Time Zone tab will be used. 

Daylight Saving Time Only: The local time zone does not switch the DST (Daylight 
Saving Time), the ‘DST’ status will be set for internal use. The settings 
“Offset from UTC“ and “DST Bias“ at the Time Zone tab will be  used. 

Same As Reference Input: The local time zone follows the status of the reference 
input (UTC, Standard Time, DST). A DST switching of the local time zone 
only occurs if the reference time zone switches. The settings “Offset from 
UTC“ and “DST Bias“ at the Time Zone tab will be  used. 

Manual 

Press the Update Now! button to let all changes at this tab immediately get effective for the 
internal calculations and the output signals of the module. Pressing this button forces to 
update/synchronize the internal clock with the reference input.  
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Mode of GT Time Zone Synchronisation 

Periodically 

The internal clock can be synchronised automatically to the reference time input. 
Mode: 

Off: No periodically synchronisation. 
Every Second: Synchronisation every second. 
Every Day: Synchronisation once a day, at the selected Hour. 
Every Week: Synchronisation once a week, at the selected Day of Week and Hour. 
Every Month: Synchronisation once a month, at the selected Day and Hour. 
Every Year: Synchronisation once a year, at the selected month Month and Day and 

Hour. 

The settings Day, Day of Week, Month and Hour will be used dependent on the “Mode“ 
selection. 

At Special Events 

Additionally to the moments selected at the Periodically setting a synchronisation can be 
programmed to occur at special events. 
After DST Switching of Reference Input: Activate this check box to synchronise the local 

time if the reference time switches the time zone (start or end of DST). The DST 
switching has to be announced in the status data of the reference input.  

After Leap Second of Reference Input: Activate this check box to synchronise the local time 
if the reference time will be corrected through a leap second. The leap second adjustment has 
to be announced in the status data of the reference input. 

 



Option “D” Daytime Inserter 
Page 24 

 

3.7 “Time Zone“: Time Zone Adjustment  
Select the time zone of the reference and the local time zone. 
Configuration (example shows a screen shot of the PC program tab): 

 

Reference Input 

The module uses the UTC (Universal Time Coordinated, GMT, world time) as an internal time 
base. With these settings and the settings Reference Input at the Reference tab the module 
can calculate the UTC from the reference input. 

Preset: 
You can select the time zone of the reference from the dropdown list. With a click on the 
button Load, the settings Offset from UTC and DST Bias will be entered automatically. 

Offset: 
Offset from UTC: Enter the sign and hours/minutes offset to UTC. 

DST Bias: Enter the DST correction value in case the reference input has a DST period. 
Most of the cases the correction value will be one hour. 
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GT Time Zone 

The module generates the local time zone. With these settings the module can calculate the 
local time zone from the internal time base (= UTC). 

Preset: 
You can select the local time zone from the dropdown list. With a click on the button Load, 
the settings Offset from UTC, DST Bias and Daylight Saving will be entered 
automatically. 

Offset: 
Offset from UTC: Enter the sign and hours/minutes offset to UTC. 

DST Bias: Enter the DST correction value in case the local time zone has a DST period. 
Most of the cases the correction value will be one hour. 

Daylight Saving: 
The local time zone may have a Daylight Saving Time (DST). These settings determine the 
moments of switching on and off the DST, referenced to the local time. 

Start: Using these inputs (e.g. last Sunday of March at 2 o’clock) GT calculates the start of 
DST for the current year. 

End: Using these inputs (e.g. last Sunday of October at 3 o’clock) GT calculates the end 
of DST for the current year. 

Aux 

These settings are of no value for AI or DI or HI or XI modules.  

Manual 

Press the Update Now! button to let all changes at this tab immediately get effective for the 
internal calculations and the output signals of the module. Pressing this button forces to 
update/synchronize the internal clock with the reference input.  
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3.8 “Link“: Communication between Modules 
Link uses the internal RS485 interface to transmit data. This interface is shared by all the 
modules in one frame, and via the RLC connector it is possible to link further modules at 
different frames. 

This module can transmit data. Link selects the channel and the kind of data. 

Configuration (example shows a screen shot of the PC program tab): 

 

Send Data 

Three channels have been provided to transmit data: 
Telegram 1, Telegram 2, Telegram 3. 

Select a function from the drop-down list: 

Off This channel will not be used to transmit data. 

Gen This channel transfers data in a time code format (frame rate = 10). 

Reference This channel transfers time and date of the internal time base (= UTC) once a 
second. This can be a time & date source for the Alpermann+Velte NTP server 
located in the Rubidium IE module.  

Display 

Adjust the parameters controlling a display (RUB D1): 

Source Select the kind of data to be sent and displayed. 
GenGenGenGen Transmits the local time in HH:MM:SS:1/10 format. 
ReferenceReferenceReferenceReference Transmits the local time in HH:MM:SS format.  

Brightness Adjust the brightness of the LEDs, steps 1 to 7. 

Secondary A click on this check box addresses the “secondary“ display. Without a click the 
“primary“ display will be addressed. 
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3.9 “Video“: Video System and General Setup of the 
Video Channel 

3.9.1 Modules AI: Analogue Video Channel 

“AI” modules have a CVBS analogue video channel. 

Configuration (example shows a screen shot of the PC program tab): 

 
System: Select the video standard: 

Auto Auto-detect of video standard. 
625/50 PAL system. 
525/59.94 NTSC system. 

It is recommended not to use the “Auto” mode if the module operates only at 
one video standard. 

Video Bypass By Relay: Option B only (Video Bypass Relay): Enables to manually switch 
to video bypass. 

 
Insert 

Enable: If this check box is activated: All video windows which have the “visible” check 
box activated (see the Insert tab) will be inserted in the video signal. 

If this check box is deactivated: Bypass of the video signal, i.e. all the video 
windows will be switched off. 

 
If you change the “Character“, “Mask“ and “Transparency“ setup you should verify the 
changes, so make sure to have a video window inserted, and connect the video output to a 
video control monitor. 
 

Character: Draw the slider to adjust the brightness of all the inserted characters. 

Mask: Draw the slider to adjust the brightness of all the background masks. 

Transparency: Draw the slider to adjust the mixing of video signal and character insertion. 
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3.9.2 Modules DI: Digital Video Channel (SD) 

“DI” modules have a serial digital video channel (SD). 

Configuration (example shows a screen shot of the PC program tab): 

 
System: Select the video standard: 

Auto Auto-detect of the video standard. 
625/50 PAL system. 
525/59.94 NTSC system. 

It is recommended not to use the “Auto” mode if the module operates only at 
one video standard. 

Channel: Setup of the video output: 
Off Video output switched off. 
On Normal operation: The video input signal passes through the 

video channel, signals will be added as programmed (visible 
video windows).  

Pass Thru The video input signal passes through the video channel, but 
the video signal will be left unchanged.  

Short Pass Thru The video input signal will be left unchanged and will be 
passed to the output with minimum delay. 

Relay Bypass Option B only (Video Bypass Relay): Enables to manually 
switch to video bypass. 

Width: Format of the serial data words: 8 bit or 10 bit. 

Insert Enable: If this check box is activated: All video windows which have the “visible” check 
box activated (see the Insert tab) will be inserted in the video signal. 

If this check box is deactivated: Bypass of the video signal, i.e. all the video 
windows will be switched off. The input to output delay will be left unchanged. 
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3.9.3 Modules HI or XI: Digital Video Channel 

“HI” modules accept digital video of HD or SD format. 

“XI” modules accept digital video of 3G or HD or SD format. 

Configuration (example shows a screen shot of the PC program tab): 

 
System: Select the video standard: 

Auto Auto-detect of the video standard. 
All other Select the video standard from the dropdown list. 

It is recommended not to use the “Auto” mode if the module operates only at 
one video standard. 

Channel: Setup of the video output: 
Off Video output switched off. 
On Normal operation: The video input signal passes through the 

video channel, signals will be added as programmed (visible 
video windows).  

Pass Thru The video input signal passes through the video channel, but 
the video signal will be left unchanged.  

Short Pass Thru The video input signal will be left unchanged and will be 
passed to the output with minimum delay. 

Relay Bypass Option B only (Video Bypass Relay): Enables to manually 
switch to video bypass. 

Width: Format of the serial data words: 8 bit or 10 bit. 

Insert Enable: If this check box is activated: All video windows which have the “visible” check 
box activated (see the Insert tab) will be inserted in the video signal. 

If this check box is deactivated: Bypass of the video signal, i.e. all the video 
windows will be switched off. The input to output delay will be left unchanged. 

Video Stream Processing 
Some data processing functions can be set independent for Video IN and Video OUT. 
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3.10 “Insert“: Setup of all Video Windows  
Each video window can get an individual setup. It is recommended to connect the video output 
to a video control monitor so you can verify the changes at this tab immediately. 

Configuration (example shows a screen shot of the PC program tab for DI/HI/XI modules): 

 

Window: Select the video window, all the following setups refer to this window. 

Visible: Click on the control box to select “visible” (window insertion switched on) or not 
visible (window insertion switched off). 

 
Position 

Horizontal: Adjust the horizontal position of the video window: Enter a number and press 
the tabulator key at the PC’s keyboard or click on the arrow keys by the side 
of the window. 

Vertical: Adjust the vertical position of the video window: Enter a number and press the 
tabulator key at the PC’s keyboard or click on the arrow keys by the side of 
the window. 

  Click on these buttons to set the video window at the upper/lower border of the 
screen. The horizontal position will be left unchanged. 

 Click on these buttons to set the video window at the most left/center/most 
right position of the screen. The vertical position will be left unchanged. 
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Values 

TC1  10 : 59 : 28 : 13  G1
Pre Text Source/Format

Delimiter
Identifier
Post Text  

Pre Text: A text can be placed right before the source characters. Enter the text and press 
the tabulator key at the PC’s keyboard. 

Source: Select the data source from the drop-down list. 

Format: Select the data format (representation of the data) from the drop-down list. 

Delimiter: Select the delimiter from the drop-down list, if the data format uses one. 

Identifier: You can add a source identifier following the source characters. Select from the 
drop-down list: 
Off = No source identifier. 
Letter = One character, e.g. “G” for generator. 
String = Two characters plus possibly a field identifier, e.g. “VR1” stays for VITC 

reader data of the first field. 

Post Text: Instead of an identifier (“Identifier = Off“) you can add a text following the source 
characters. Enter the text and press the tabulator key at the PC’s keyboard. 

 

Character 

Font: Select the character font from the drop-down list: 

Font Pixel Matrix max. characters max. windows 
 H x V (*) horizontal (about) vertical (about) 
16 10 x 16 63 32 
20 12 x 20 52 25 
24 14 x 24 44 21 
28 16 x 28 39 18 
36 20 x 36 31 14 
48 27 x 48 23 11 
64 35 x 64 17   8 
72 39 x 72 16   7 
(*: Pixel clock horizontal = 13.5 MHz, vertical = “interlaced“ video line) 

Color: Modules DI/HI/XI only: Select the colour of the character insertion. The current 
colour is indicated. Click on the Change... button to change the colour. Refer to the 
description below for more information. 
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Mask 

A background mask can be added to the character insertion. Select from the drop-down list: 
 
Mode: Off No background mask. 

Solid With background mask. 
Dimmed Modules DI/HI/XI only: Reducing the luminance of the video signal in the 

video window area. 
 
Color: Modules DI/HI/XI only: Select the colour of the background mask (“Mode” = “Solid” 

only). The current colour is indicated. Click on the Change... button to change the 
colour. Refer to the description below for more information. 

 

Modules DI/HI/XI only: 

Change...: Select the colour of the character insertion or the background mask: 

 
Click on any of the colour boxes to use an already defined colour: “Basic color” 
or “Custom color”. 

If you want to define your own colour you can: 

• Enter a value in the Hue, Sat, Lum boxes. 

• Enter a value in the Ret, Green, Blue boxes. 

• Select colour and saturation: Use the mouse button to draw the pointer at 
any place within the colour spectrum. Select brightness: Use the mouse 
button to draw the pointer at any place within the brightness bar. 

Press the OK button at the end. 

 



Option “D” Daytime Inserter 
Page 33 

 

4 Options 

4.1 Option B: Video Bypass Relay 
With this option the module is equipped with a bypass relay: 

• The bypass relay appears in the video input to output path, not in the video loop path. 

• The main functionality is to maintain the video path even in an event of power failure. 

• The bypass relay can be switched remote controlled by a GPI function: A function key 
or one of the GPI inputs can be programmed with the “GPI: Relay Bypass” function 
(see the “Keys” page of a Rubidium configuration tool). 

 

Technical data of the relay: 

Modules AI 
Initial insulation resistance  100 MΩ minimum 
Initial contact resistance 50 mΩ maximum 
Max switching power 24 W  
Max switching current 1 A 
Max switching voltage 24 V 

Modules DI 
Cutoff frequency  1 GHz 
Insertion loss < 1 dB 
Impedance 75 Ω 
Max switching power 24 W  
Max switching current 1 A 
Max switching voltage 24 V 

Modules HI or XI 
Cutoff frequency  2.6 GHz 
V.S.W.R. Max. 1.5 
Insertion loss < 1 dB 
Impedance 75 Ω 
Max switching power 1 W  
Max switching current 0.5 A 
Max switching voltage 30 V 

 

 

 


